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Abstract

This study is aiming to investigate the role of personal and collective work identity. More

precisely, the emotional component of work identity was more pronounced in personal work-

bonding relationships, and the cognitive component, of work identity, in contrast, was more 

pronounced in collective work-bonding relationships.
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Week 4 Discussion Question Paper

[The body of your paper uses a half-inch first line indent and is double-spaced.  APA style

provides for up to five heading levels, shown in the paragraphs that follow.  Note that the word 

Introduction should not be used as an initial heading, as it’s assumed that your paper begins with 

an introduction.]

Define organizational behavior? What is its focus?

organizational behavior organization is a combination of different individuals who work 

either in a team or individually. When the individuals work in the form of a team, the 

performance of each individual matters in the final accomplishment of the team goals, as the 

given case indicates that one of the team members is lacking the required level of commitment, it

can create a significant issue for the rest of the team members as his or her lack of commitment 

may drag the performance of the entire team. In this situation, as a manager, I would invite that 

individual and have a face to face interaction with him. I will ask the individual about the level 

of performance and involvement in the team. I will also ask him or her how does he or she rate 

his or her performance. In order to provide the real picture of the performance, I would compare 

the level of performance and involvement of him or her with the rest of the team members. I will 

also utter to the individual that as he or she is working in the team, then his or her performance 

and involvement also plays a significant role. I would ask the reason for the lower performance, 

why he or she is not motivated if he or she faces any issue in the team or the job assigned to him,

or her is not motivating. I will tell him that the teams are mean for the collaborative efforts, and 

if the performance of one of the members drops, this will reflect in the overall performance of 

the team. I will also explain the advantages of working in a team as there are many members, so 

everyone is curious and active to help the other members, and if there is any issue, he or she 
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must interact with the team leader. In the above response, the source of interaction will be the 

performance record of the team member, the receiver will be the individual who is having a lack 

of commitment, and the message will include the reasons and factors to put the best effort in the 

team.

Do companies have a responsibility to raise women’s salaries to accommodate their roles as

primary breadwinners? Why or why not?1

Families have evolved over the years. No longer do we just see the traditional families that 
involve a man, woman, and children. Now more diversity exists among the different forms of 
families, and as a result, there is a change in the family tends. In addition to this change in the 
dynamic of families, we are also seeing a change in the gender roles within families. No longer 
are families or society sticking to the norm that men are the sole breadwinner and head of the 
household. Women are taking on more of the economic responsibility of the household, whereas 
men are taking on more responsibility regarding the caring of the house. For instance, men are 
helping more in taking care of the children, maintaining the cleanliness of the home in addition 
to their normal responsibilities of providing. The roles of families are no longer well-defined. 
Roles within families change daily or to accommodate the needs of the family at the time. After 
doing some research, I found two sources that give information on the change we see in family 
roles. One article discusses the role of fathers in a family, and the other discusses the role of 
genders within a family. Raising the salaries of women to make them primary breadwinners 
means discrimination on sexual grounds. Companies must not discriminate males or females in 
raising salaries, and this must depend on their abilities and performance. When deciding to raise 
salaries, companies must consider employees and not male or female. Hence, they must not raise 
women's salaries, which shows they are biased and hence must raise the salaries of their 
employees to accommodate their role as primary breadwinners.

Briefly describe the elements of the formal and informal organization. Give 

examples of each.

The formal organization is made from the hierarchical relationships between people 

working in an organization. The formal structure of an organization can be seen from its 

organizational chart. Elements of a formal organization include objectives, job description, 

financial structure, policies, and authoritative structures. Informal organizations are established. 

As a result, social relationships between the people working in an organization. Elements of the 

formal organization include perception, attitudes, group norms, feelings, and values of 
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employees. Examples of formal organizations include organizations having well defined 

organizational structures like Nike, Dell, and Toyota. An example of an informal organization 

includes communities of common interest and social networks.

What are the potential benefits and problems of diversity?

The workforce in an organization is diversified based on different characteristics like age,

culture, gender, religion, personality, sexual orientation, and the social status of the people. The 

workforce diversity has both advantages as well as disadvantages for a firm. employees can 

utilize diversity management to attract and retain their employees. it would help them improve 

their decision-making ability, adopt flexibility, develop innovative products, and enhance their 

marketing approach potential disadvantages of workforce diversity include the employee's 

resistance to change, communication problems, workplace conflicts, and poor coordination 

among team members.

What are individual differences, and why should managers understand them?

What are some of the ethical challenges encountered in organizations?

currently, an organization working across the globe are facing the following ethical 

challenges. 

 Environmental issues created due to the company's operations like emission of 

harmful chemicals and gases or excessive use of natural resources. 

 Employer's biasness towards employees of different cultural and social norms. 

 Increasing cases of sexual harassment. 

 conflicts of interest at work. 

 employee theft. 

 Employer's biasness towards a female employee.  
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How do some companies accommodate the differing needs of a diverse workforce?

Workforce diversity is one of the most significant advantages of the modern world. It has 

enabled companies to increase their productivity, creativity, and reputation. However, 

accommodating the requirements of a diverse workforce is also a challenge for the companies. 

People having different cultures, values and beliefs have different sets of requirements. 

companies can adhere to their requirements with the help of the following techniques:

 promote harmony at the workplace using cross-cultural sensitivity 

 strictly regulate the anti-discrimination policies at the workplace based on gender,

race, age, or ethnic origin.

 organizations can encourage their managers to develop a global perspective by 

conducting workshops and seminars on cross-cultural sensitivity workshops 

 furthermore, the organizations can promote cross-cultural task force to avoid the 

cultural barriers among the employees and the managers

What are individual differences, and why should managers understand them?

Individual differences represent different factors that provide uniqueness to each 

individual; these differences include varying sets of personalities, attitudes, perceptions, skills, 

abilities, values, and ethics of individuals.

Managers face challenges to work with people possessing different characteristics, social 

perceptions, and attributions of causality. They need to understand individual differences to 

recognize the unique requirements of employees. It helps them to address the employee's needs 

more effectively.
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Suppose you have an employee whose lack of commitment is affecting others in the 

work group. How would you go about persuading the person to change this attitude?

Attitude may define as the tendency or learned predispositions that we show towards an 

aspect of our environment.

A person’s attitude is because of the value and belief that one possesses or has been 

accumulated over time. So, persuading the person to change this attitude, one must first see 

through the belief and value.

The person may have that attitude because of compliance, which is founded on the 

fundamental idea that people want to be accurate and right. Thus, in the group, he might not like 

it if some one’s idea is taken, and he is discarded. Thus, this might gradually lead to a lack of 

commitment.

Thus, he must be adequately explained why he is wrong and give in some change to give 

an idea on any project and accept it to as to motivate him.

What are the five categories of motivational needs described by Maslow? Give an 

example of how each can be satisfied

Motivational need theory is a theory of of motivation that emphasis on interpersonal or 
psychological needs of an individual. The theory is based on needs hierarchy.
The following are the five basic needs in Maslow's need hierarchy

 physiological needs: the physical requirements that are needed for human survival are 
called physiological needs. The human body will not function properly in the absence of 
these requirements

 safety needs: physical safety, as well as economic, are required to live a peaceful life love
and belonging these needs start developing in a person since childhood. People make and 
maintain significant relationships, such as friendship, family, and intimacy.

 Esteem: this need represents the urge of a person to feel respected and valued.
 Self-actualization: this kind of need refers to the realization of a person's potential about 

themselves.
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Footnotes

1[Add footnotes, if any, on their own page following references.  For APA formatting 

requirements, it’s easy to just type your own footnote references and notes.  To format a footnote 

reference, select the number and then, on the Home tab, in the Styles gallery, click Footnote 

Reference.  The body of a footnote, such as this example, uses the Normal text style.  (Note:  If 

you delete this sample footnote, don’t forget to delete its in-text reference as well.  That’s at the 

end of the sample Heading 2 paragraph on the first page of body content in this template.)]
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Column Head Column Head Column Head Column Head Column Head
Row Head 123 123 123 123
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Row Head 123 123 123 123
Row Head 456 456 456 456
Row Head 789 789 789 789

Note:  [Place all tables for your paper in a tables section, following references (and, if applicable,

footnotes).  Start a new page for each table, include a table number and table title for each, as 

shown on this page.  All explanatory text appears in a table note that follows the table, such as 

this one.  Use the Table/Figure style, available on the Home tab, in the Styles gallery, to get the 

spacing between table and note.  Tables in APA format can use single or 1.5 line spacing.  

Include a heading for every row and column, even if the content seems obvious.  A default table 

style has been setup for this template that fits APA guidelines.  To insert a table, on the Insert tab,

click Table.]
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Figures title:

Category 1 Category 2 Category 3 Category 4
0

1

2

3

4

5

6

Series 1 Series 2 Series 3

Figure 1. [Include all figures in their own section, following references (and footnotes and tables,

if applicable).  Include a numbered caption for each figure.  Use the Table/Figure style for easy 

spacing between figure and caption.]

For more information about all elements of APA formatting, please consult the APA Style 

Manual, 6th Edition.
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